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1. Introduction to Galileo Desktop SSL 
 

1.1 How does it work? 
This solution allows Galileo customers to access Galileo via a SSL (Secured Socket Layer) connection using their 
own Internet connection. Customers are responsible for procuring their own dedicated Internet connection, which 
can be DSL, cable, T1, etc.  
By deploying this solution, Galileo allows an agency to use the Galileo Host via their chosen Internet Service 
Provider. 
 
Definition of Secured Socket Layer connection 
SSL, short for Secure Sockets Layer, is a protocol for transmitting private documents/information via the internet. 
The Galileo SSL client will enable agents existing IP workstations and print servers to access Galileo over the 
public Internet via an encrypted, secured connection.  The client install is transparent and does not require an 
agent to change any existing workstation configurations or agency workflow.  
Once the SSL connection has been established, users will have direct access to the Galileo Host using the 
Galileo Desktop software. 
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After the installation, the Galileo SSL client will run as a Windows service and will set-up an SSL connection to 
gdssl.galileo.com or sslfpemea.galileo.com on port 443 
The SSL connection is automatically started on system start-up and will provide Galileo access for all the Galileo 
used products.  
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1.2 Client Identifiers and GTIDs 
 
Each Galileo Desktop Workstation will receive a unique combination of a Client ID (Client Identifier) and a GTID 
(Galileo Terminal Identifier). 
This information will be provided by your Galileo representative in the form of a Galileo Desktop SSL 
configuration sheet. 
A typical agency will have at least 1 DWS (Combined PrintServer and workstation) and an 
IWS (workstation) for each additional Galileo User. 
The difference between a DWS and an IWS is the installation of the Galileo PrintManager software. Galileo 
PrintManager will provide host printing functionality to a travel agency.  
During the installation of the Galileo software you will be requested to fill-in your ClientID details. 
An example of a ClientID is: G0XK800H. 
A GTID (Galileo Terminal Identifier) is a hexadecimal number which is used to start a session on the Galileo 
Host. Each workstation, printer or MIR has its own GTID. The total number of GTIDs is determined during the 
provisioning stage. An example of a GTID is GTID is C2FF10.  
 

1.3 Software and Hardware Requirements  
 
Note: Please install Galileo Desktop under the supervision of someone with a working knowledge of your office 
hardware.  
 
Hardware Requirements  
 
Requirement   Minimum   Recommended  
Processor   266Mhz Pentium  1 GHz  
RAM    128MB    512MB  
 
Temp hard drive space  400MB   
Permanent disk space  200MB  Note: Additional space is required for Internet Explorer  
Resolution  800x600    1024x768 (16bit colour or higher colour is recommended). 
 
 
Software Requirements  
 

• Windows® 2000 (Service Pack 4), or Windows® XP (Home or Professional Edition), Windows® Vista. 
• Microsoft® Internet Explorer 6.0 and above. 
• Net 2.0 or above needs to be installed, if not present, the install will automatically download the 

software from Microsoft. 
• Microsoft Installer 3.1 v2 (KB893803) if Windows 2000 or XP is being used 
• MSXML 6.0 or above needs to be installed, if not present, the Galileo Desktop install will 

automatically install it for you. 
 

Note: 
• Installer must have Administrative rights 
• Please install Galileo Desktop SSL under the supervision of someone with a working 

knowledge of your office hardware. 
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Citrix® Options: 
This installation is fully compatible with most Citrix® application servers currently supported by Citrix and is 
available for Microsoft® Terminal Service users.  

• NT 2000 Terminal Server  
• NT 2000 Microsoft® Terminal Server with Citrix® MetaFrame XP 1.0&XPe 1.0 both Windows® client and 

NFuse Portal Server.  
• Citrix Presentation Server 4.0 on Windows Server 2003.  

 
The installation determines the Windows® platform as well as the version of MS Internet Explorer you are using. 
You may need to know the CD-ROM drive letter designation if you intend to access the applications from a CD-
ROM drive that is shared. 
 

1.4 Galileo Desktop SSL Product suite. 
 
 
De Galileo Desktop SSL product suite contains the following programs: 
 
CLIENT APPLICATIONS 
• GalileoSSLClient_v01.00.0003. 
• Galileo Desktop 2.0, or higher. 
• EMEA Viewpoint Scripts. (Customized booking processes in script form) 

 
HOST PRINTING APPLICATIONS 
• Galileo Print Manager 4.00.01 (Galileo Host prints like Itineraries Mir and e-ticket supports documents. 

 
DOCUMENTATION 
• Galileo Desktop SSL Installation guide. 
• Galileo Desktop Userguide. 

 
The software and documentation can be either downloaded from a Galileo service portal in your region or 
it will be send to you on CD together with your Galileo SSL configuration details. 
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2. The Galileo SSL client installation 
 

The Galileo SSL client will manage the SSL connection to the Galileo SSL server (sslfpemea.galileo.com). 
After de installation the Galileo SSL client will run as a Windows service. 
To start the installation, please run the GalileoSSLClient_v01.00.0003.exe. 
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Make sure you are logged on as a local administrator and you have met all the necessary hardware and 
software requirements. 
 
 
Start the Galileo SSL client installation by 
running the GalileoSSLClient_v01.00.0003.exe 
 

 
 
 
 
 
 
 
 
 
 
 
You will receive the following dialog box if you do not have the correct Windows 
installer version on your system. 
Windows 2000 or Windows XP at least needs to have Windows installer 3.1 v2 
active on your system. 
Please download the installer from Microsoft via the link below 
and restart the Galileo SSL client installation. 
 
http://www.microsoft.com/downloads/details.aspx?FamilyID=889482FC-5F56-4A38-B838-
DE776FD4138C&displaylang=en 
 
The installation will continue ones it detects 
the correct Windows installer. 
Next the installation will check your Microsoft 
dotnet version. 
Dotnet 2.0 or above needs to be installed, if 
not present, the Galileo SSL installation will 
automatically download and install it on your 
system.  
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Please install the dotnetfx update 
by clicking on Run 
 
 
 
 
 
 
 
Please click Next in the Welcome to Microsoft.Net dialog box 
 
 
 
Accept the terms of the License agreement and click on Install 
to continue the dotnetfx installation update. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The dotnetfx update is successfully installed on your system. 
Click on Finish to continue with the Galileo SSL client 
installation 
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After the dotnetfx update the installer automatically continues 
with the installation of the Galileo SSL client. 
Click Next to continue 
 
 
 
 
 
 
 
 
 
 
 
The Terms and Conditions window appears.  
Please acknowledge the terms and 
Conditions and click Next to continue 
 
 
 
 
 
 
 
 
 
 
 
 
The Galileo SSL client is successfully installed on your system. 
Click Finish to end the  
 
 
 
 
 
If you want to check if the Galileo SSL tunnel is active on your 
system, please go to Control panel (Classic View) and click on 
Administrative Tools and then on Services. 
Check if the highlighted service below is started. 
 
 
 
 
 
 
 
 
 
 
 
 
The SSL service will automatically start on system start-up, so it is not necessary to start is manually. 
Please continue with the installation of Galileo Desktop. 
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3. The Galileo Desktop Installation. 
 
If you already have an older version of Focalpoint or Galileo Desktop installed than please make sure  
You perform the following Primary checks 
 
Please skip this section if you do not have an older version of Focalpoint or Galileo Desktop installed on 
your system. Go directly to section 3.2 Installing Galileo Desktop 
 

3.1 Primary checks. 
 
Before the installation begins, the following primary system checks are made. If your operating system fails to 
meet any one of these checks, the installation will abort. 
 

• Do you require/have administrative privileges? 
• Is the resolution set to at least 1024x768? 
• Is the colour depth at least 256 colours? 
• Is there sufficient disk space? 
• Is the operating system Windows® 2000 SP4 or higher? 
• Microsoft® Internet Explorer 6.0 or higher present on your 

desktop? If not, you will be prompted to upgrade. 
 
Before you begin  
 

• If you are running Focalpoint® 3.2, or Focalpoint® 3.0.18A,  
remove the icon from your desktop (right-click the icon and select Delete). 

• Make a note of your Client ID and IP configuration settings. 
Go to the Control Panel/Galileo TCP/IP settings for this information. 

• Disable any anti-virus software you may have running. 
Antivirus software may prevent registries from being updated. 

 
Pre-installation requirements  
At the beginning of the installation, you will encounter the Setup dialog. You must click Yes before you can 
proceed with the installation. The following tables will help you find the files you want to backup. When the 
installation is complete, you are reminded to reinstate these files. 
 
 

 
Note: If you are not familiar with how to back up files, please 
check with your manager/IT manager. File locations for each 
question are listed the following page.  
Have you backed up your data files? 
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File Type  If you are installing over 

Focalpoint® 3.5  If you are installing over Galileo Desktop  

Replay Files  \FP\REPLAY\*.*  \FP\REPLAY\*.*  

Scriptwriter Plus 
Files  

\FP\DATADIR\SWPLUS\SCRIPTS\*.* \FP\DATADIR\SWPLUS\SCRIPTS\*.*  

Browser Script 
Files  

\FP\DATADIR\SCRIPTS\*.*  \FP\DATADIR\SCRIPTS\*.*  

Have you saved your preferences and settings?  

File Type  If you are installing over 
Focalpoint® 3.5  If you are installing over Galileo Desktop  

Focalpoint 
Config File  

 \FP\DATADIR\WSTN\focalpoint.config.xml 
\FP\DATADIR\USER\users\focalpoint.config.xml  

Scriptwriter run \FP\DATADIR\WSTN\GRP*.SWR   
   

 
Have you backed up your Pkeys?  

File Type  If you are installing over 
Focalpoint® 3.5  If you are installing over Galileo Desktop  

Apollo® Keys  \FP\DATADIR\PKEYS\*.ALC   

Galileo® Keys  \FP\DATADIR\PKEYS\*.CPR   

Galileo Desktop  
 \FP\DATADIR\PKEYS\*.PKEYS.XML  

 
Have you backed up any Viewpoint Customization?  

 
Have you backed up your script library?  

File Type  If you are installing over 
Focalpoint® 3.5  If you are installing over Galileo Desktop  

Galileo Java 
Script Library  

 \FP\SWDIR\CustomViewpointGalileo\CustomViewpoi 
ntGalileo  

Java Script 
Library Val Files  

 \FP\SWDIR\CustomViewpointGalileo\CustomViewpoi 
ntGalileo\gdia_ValFiles  
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3.2 Installing Galileo Desktop. 
 
Start the Galileo Desktop installation by 
running the Galileo Desktop 2.1.exe 
 
The Setup dialog box appears.  
Confirm that all of the applicable items are backed up; click Yes to 
uninstall your current version of Galileo Desktop.  
For additional information on these pre-installation tasks, see the 
section titled: Pre-installation Requirements.  
InstallShield prepares the install. A progress box may appear 
 
 
 
 
Galileo Desktop 2.1 requires MSXML 6.0 to operate correctly. 
MSXML 6.0 Update (Required if not loaded)  
The install will check to ensure it is installed. If it is not present on 
your workstation, the Galileo Desktop installation will begin to install 
MSXML 6.0 first. 
The following screens appear. 
Click OK to begin the installation.  
 
 
 
 
The MSXML 6.0 parser Setup dialog box appears 
Click Next to start the installation.  
 
 
 
 
 
 
 
 
 
 
 
 
Click I accept the terms in the license agreement button.  
Click Next to continue  
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Enter your Name and Company Name and click Next.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Ready to install the program dialog box appears 
Click Install. To continue 
 
 
 
 
 
 
 
 
 
 
 
 
Click Finish. The MSXML update is now installed. 
The Galileo Desktop installation will continue automatically. 
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The Welcome to the Install shield wizard for Galileo Desktop dialog 
box appears. Click Next to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
The License agreement dialog box appears 
Click Yes to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Set-up type dialog box appears.  
 
Choose which Galileo Desktop mode you want to start-up with and 
click Next to continue 
 
 
 
 
 
 
 
 
 
 
 
Choose if you want Galileo Desktop to start automatically on boot-up 
and click Next to continue. 
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Please select the desired language. 
Use the ctrl key to select multiple languages 
Click Next to continue 
 
 
 
The Default directory overview 
dialog box appears. 
Click Next to continue 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The connection dialog box appears. 
Please fill in the following settings 

• Galileo assigned Client Identifier 
you can find this information on your  
Galileo configuration sheet. 

• Use Apollo/Galileo Mapped Keyboard mode. 
• Use Fixed configuration server addresses 

Primary and secondary are both 127.0.0.1 
• Check the force download box 

 
Click Ok and again OK to save these settings and continue 
 
 
 
 
 
 
 
 
 
 
 
You have now created your Galileo connection profile. 
Please click Ok to continue with the installation. 
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The Select Features dialog box appears 
Click Next to continue 
 
If you deselect any of these option than that option will not be 
available after the installation. 
A re-install is necessary to add a deselected feature. 
 
 
 
 
 
 
The next Select Features dialog box appears 
Click Next to continue 
Use Italian Relay only when your 
agency is based in Italy.  
 
 
 
Select all the available relay features 
and click Next to continue 
 
 
 
 
 
 
All available Galileo Desktop features have been selected. 
The Galileo Desktop software is now being installed. 
 
 
 
The Setup type dialog box appears. Choose Use local MS Access 
database and click Next to continue 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The InstallShield Wizard Complete dialog box appears. 
Click Finish, the Galileo Desktop software is now successfully installed on your system. 
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3.3 Starting Galileo Desktop for the first time. 
 
Double click on the Galileo Desktop icon on your desktop to start 
Galileo Desktop. 
 
The Galileo Desktop Logon screen 
appears; click on the Start Galileo Desktop button. 
You can also start Galileo Desktop via  
START→PROGRAMS→ Galileo Desktop → Galileo Desktop. 
 
As this is the first time Galileo Desktop is started on this system, it will 
automatically downloads it’s configuration from the Galileo Host. 
Enter your Galileo Desktop Sign On (son/zXXX) in one of the four 
Galileo windows. 
You will receive a sign on complete from the Galileo Host.  
You are now connected and signed on to the Galileo host.  

3.4 Reconfigure Galileo Desktop after the installation. 
 
Use the following steps if you want to reconfigure Galileo Desktop on 
your system. 
1. Close Galileo Desktop. 
2. Go to Start → Settings→ Control Panel 
3. Dubbel click the Galileo TCP/IP icon.  

The Host/Galileo Desktop TCP/IP configuration dialog box appears. 
4. Highlight your current connection and click Edit to open the 

selected connection.  
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5. The connection Dialog box appears 
Change the ClientID, check the Force Download box and click Ok to 
save the new settings. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
6. Click Ok to exit the he Host/Galileo Desktop TCP/IP 

configuration dialog box. 
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3.5 Custom Viewpoints Scripts 
 
The Custom Viewpoint scripts installation will provide you with a number of ready to use scripts to automate a 
number of workflow functions within Galileo Desktop. 
 
Once installed, the Custom Viewpoint scripts are accessed through 
Custom Viewpoint™. Make sure that in the terminal windows 
screen under options you have activated; View Custom 
Viewpoint 
 
The Custom Viewpoint scripts are designed for customers who are 
using version Galileo Desktop versions 1.01, 2.0 and 2.1 
You can run the Galileo Desktop Custom Viewpoint scripts and 
Scriptwriter 
Plus™ scripts in conjunction with each other.  
 
 
If you want to use the Custom Viewpoint Scripts please install the EMEA_Script_2.0.exe software using the 
following installation procedure. 
 
1. Close Galileo Desktop  
2. Start the EMEA_Script_2.0.exe  
3. The CustomViewpoint Scripts 2.0 Set-up dialog box appears, 

click Next to continue. 
 
 
 
 
 

4. The Set-up type dialog box appears. Choose 
custom only if you have changed the default 
Galileo Desktop installation directories.  
Choose standard if you have made no changes 
to the default Galileo Desktop installation 
directories. 
Click Next to start the Custom 
Viewpoint Scripts installation. 
 
 

5.  The InstallShield Wizard 
Complete dialog box appears. 
Click Finish, to end the 
installation. 

 
 
 
 
 
The Custom Viewpoints Scripts software is now successfully installed on your system 
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4. Galileo Print Manager Installation (GPM) 
 
Galileo Print Manager (GPM) is used to print booking related content like Itineraries, agency coupons and back-
office information (MIR).  
 
If you only want to print Galileo related content, than you only need to install the GPM software. 
If you want to print 3P

rd
P party rail document besides the Galileo related content, than you need to Contact 

your Galileo representative and ask for the Galileo Desktop SSL_Rail version which is compatible with 3P

rd
P 

party printing services. 
 
The GPM software receives print messages from the Galileo host and it will relay these messages to the locally 
configured printer ports, network printers or file shares. All hardcopy printers have to be configured in Windows 
first before GPM is able to use them. 
 
1. Run the GPM4.0.exe to start the Galileo Print Manager 

installation. The GPM setup dialog box appears. 
Click Next to continue. 

 
 
 
 
 
 
 
 
 
 
2. The Setup Type dialog box appears 

Choose typical ATB and click Next to continue  
 
 
 
 
 
 
 
 
 
 
 
 
3. The Enter Client ID dialog box appears. Enter your GPM ClientID 

in capitals and Click Next to continue. The Client ID information 
can be found on your Configuration sheet provided by Galileo. 
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4. The GPM Selections dialog box appears. Check the Add GPM to 
the start-up menu option and click Next to continue. 
 
 
 
 
 
 
 
 
 
 

5. The Start Copying Files dialog box appears. 
Click Next to continue. The Setup will now start installing all the 
necessary files. The Setup will install the GPM software in 
C:\PROGRAM FILES\FOCALPOINT\DPS\. 
The GPM configuration information will be stored in 
C:\MY DOCUMENTS\FOCALPOINT PM\. 
 
 
 
 
 
 
 
 

6. The Enter GPM configuration dialog box appears. 
Mark Use Fixed Configuration Server Addresses 
and fill in the addresses below 
Primary Server      = 127.0.0.1 
Secondary Server = 127.0.0.1 
Click OK to continue 
 
 
 
 
 
 
 
 
 

7. The Setup Complete dialog box appears 
Choose No I will restart my computer later and click Finish to 
end the installation. 

 
 
 
 
 
 
The GPM software is now successfully installed on your system. Please continue with the configuration 
of Galileo Print Manager 
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4.1 Galileo Print Manger configuration 
 
The Galileo PrintManager (GPM) software is now installed and the GPM will start automatically on start-up. 
Because this is the first time GPM is started it needs to receive a configuration download from the host. Ones 
it has received its configuration download you can continuing with the configurations of printers in the GPM. 
Go to START→PROGRAMS→ Galileo Print Manager → Print Manager 
To start the Galileo Print Manager software 
The Galileo Print Manager dialog box appears. 
 
In the GPM dialog box go to: 
Tools→Connect On Start-up. 
This will make sure that GPM automatically connects to the 
Galileo host on system start-up 
 
In the GPM dialog box go to: 
Tools→Auto-configure. 
Click on Auto-configure and GPM will request a configuration 
download from the Galileo Host. 
If this configuration download is successful, a check will appear 
in the Auto-configured box. 
 
You can check if you have received a configuration download 
by clicking on the GTID tab. 
When you received a configuration download from the Galileo 
Host you will find here a list of printer GTIDs which are assigned to you. 
 
The GPM has received its configuration and it needs to be saved. The easiest way to save the new 
configuration is to close GPM. Click in the GPM dialog box on File→Exit  
The GPM Save changes to Host dialog box appears.  
Click YES and the GPM configuration will be saved. 
 
The GPM is now installed and it has received a configuration download. 
If you start your PC in the morning, GPM will automatically run at start-up. 
You need GPM to be operational if you want to print Itineraries or Tickets. 
Please continue with the local printer configuration for GPM.  
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4.1 Installation of printers under GPM 
 
Make sure Galileo Print Manager is closed 
Go to START→PROGRAMS→ Galileo Print Manager → Configurations 
 
The exploring Galileo Print Manager dialog box appears. In the dialog 
box you will find a number of icons. The second icon is the default 
ATB device and the third icon is your default Itinerary printer. 
Go to: View → Toolbar, View → details to see the device numbers 
 
Each printer has a device number, which corresponds with the device 
number found in the Galileo Print Manager GTIDs dialog box. This way it is easy to distinguish which device 
number belongs to what printer type. 
In the next several pages we will show you how to configure your printers. 
After the installation of the printers it is recommended to restart your PC. 

 

4.1.1 The installation of the first Itinerary printer 
 
It is necessary to have your agency printers configured on your Windows system, if you want to 
be able to send a Galileo host print to one of your local printers. 
 
Make sure that Galileo Print Manager is not active at this moment. Go to: Start → Programs → Focalpoint 
GPM → Configurations. 
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The installation of GPM has automatically generated a ‘Default ATB’ and a ‘Default Itinerary’ device. 
Please delete both devices. 
 
If you want to install an Itinerary printer,  
Go to: File → New → Device  
This will start a printer installation wizard. 
 
Choose a device number that is available but not in use. Fill in a 
device name of your choice. This name will be visible later in the 
configuration dialog box. 
Choose the correct Printer Type and click Next. 
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The available Printers dialog box appears. You will find all the 
printers configured under Windows listed here. Make a choice 
which printer you want to use as an Itinerary printer by 
highlighting this printer. 
Remove the check from the use the default printer box and click 
on Next to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
In this dialog box you may enter additional information 
concerning this printer.  
This is not necessary; you may leave this blank if you wish. 
Click Next to continue. 
 
 
 
 
 
 
 
 
 
 
In this dialog box you are asked if you would like to print a test 
print. 
This is only a local test print and it indicates that the 
workstation is able to print to the specified printer. 
Make your choice and click Finish to end the printer 
installation wizard. 
 
 
 
 
 
 
Continue the above mentioned steps for every additional Itinerary you would like to configure 
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4.1.2 The installation of a MIR device 
 
A Machineable Interface Record (MIR) contains booking information, which can be used in Back-office 
systems. 
 
A MIR can be received in two different ways: 
• To a directory on the hard disk or network share. The MIR is configured on the GPM as Mir to disk. 
• To a serial port. The MIR is configured on the GPM as MIR to port. 
Each MIR receives a unique filename and this makes it possible for the back-office system to read the 
information in this file and keep track of which file is already processed by the back-office system. 
 
Mir to disk 
Follow the same steps as if you would install a printer. 
Choose a directory where you would like the Mir files to be sent to. Click Next and add some comments if 
necessary to clearly outline the purpose of this device. 
Click Next to end the installation of Mir to disk 
The MIR to disk device is now added to the Focalpoint Print Manager Configuration file. Start GPM (Start → 
Programs → Galileo Print Manager → Print Manager). 
 
 
Mir to port 
Follow the same steps as if you would install a printer. 
Click on the ‘Port’ tab and choose the serial port where the back-office system is connected. 
Click on Configure Port and set the port settings to reflect settings given by your back-office system 
supplier. If you do not know the port settings for your back-office system, use the standard setting given 
below. 
 
Bits per second:  1200 
Data bits:   8 
Parity:   None 
Stop bits:   1 
Flow control   None 
 
Click on the Advanced button (Settings button when using Windows NT). 
Set FIFO buffers off (remove check) and click OK. 
Again click on OK → OK to close installation screen. 
The new port settings are active immediately. The MIR to port device is now added to the Galileo Print 
Manager Configuration file. 
Start GPM (Start → Programs → Galileo Print Manager → Print Manager). 
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4.1.3 MIR file Example 
 
If you print a MIR it looks like this: 

 
T51G773392007240095409JAN981159   000                        15MAR98E56A21E56A3F 
 XF6 XF688888881 3VP7MP         N99999NXTAG09JAN9800009JAN98011 
   000000000000 NLG00000000  00000000  00000000  00000000  00000000  00000000                    
N NNN0N NAYA NNNX   NL                              
000000001000002000000000000000001000000000000000 
A02TESTIGNORE/XMR                              8          00                    
A0401KL074KLM ROYAL DU 119J AK15MAR1140 1205 2AMSAMSTERDAM    LHRLONDON/HEATHRIN    O0   737         F AC:KLM CITYHOPPTK:NJT:01.25 
A0402KL074KLM ROYAL DU 120J AK27MAR1300 1510 2LHRLONDON/HEATHRAMSAMSTERDAM    INO   O0   735         F AC:KLM CITYHOPPTK:NJT:01.10 
A12AMST *GALILEO TEST 020-6487511 

 
In hexadecimal form a MIR looks like this: 
 

00000000:  54 35 31 47 37 37 33 33 - 39 32 30 30 37 32 34 30 T51G773392007240 
00000010:  30 39 35 34 30 39 4A 41 - 4E 39 38 31 31 35 39 20 095409JAN981159 
00000020:  20 20 30 30 30 20 20 20 - 20 20 20 20 20 20 20 20   000 
00000030:  20 20 20 20 20 20 20 20 - 20 20 20 20 20 31 35 4D              15M 
00000040:  41 52 39 38 45 35 36 41 - 32 31 45 35 36 41 33 46 AR98E56A21E56A3F 
00000050:  0D 20 58 46 36 20 58 46 - 36 38 38 38 38 38 38 38   XF6 XF68888888 
00000060:  31 20 33 56 50 37 4D 50 - 20 20 20 20 20 20 20 20 1 3VP7MP 
00000070:  20 4E 39 39 39 39 39 4E - 58 54 41 47 30 39 4A 41  N99999NXTAG09JA 
00000080:  4E 39 38 30 30 30 30 39 - 4A 41 4E 39 38 30 31 31 N9800009JAN98011   
00000090:  0D 20 20 20 30 30 30 30 - 30 30 30 30 30 30 30 30     000000000000   
000000A0:  20 4E 4C 47 30 30 30 30 - 30 30 30 30 20 20 30 30  NLG00000000  00   
000000B0:  30 30 30 30 30 30 20 20 - 30 30 30 30 30 30 30 30 000000  00000000   
000000C0:  20 20 30 30 30 30 30 30 - 30 30 20 20 30 30 30 30   00000000  0000   
000000D0:  30 30 30 30 20 20 30 30 - 30 30 30 30 30 30 20 20 0000  00000000     
000000E0:  20 20 20 20 20 20 20 20 - 20 20 20 20 20 20 20 20                    
000000F0:  20 0D 4E 20 4E 4E 4E 30 - 4E 20 4E 41 59 41 20 4E   N NNN0N NAYA N   
00000100:  4E 4E 58 20 20 20 4E 4C - 20 20 20 20 20 20 20 20 NNX   NL           
00000110:  20 20 20 20 20 20 20 20 - 20 20 20 20 20 20 20 20                    
00000120:  20 20 20 20 20 0D 30 30 - 30 30 30 30 30 30 31 30       0000000010   
00000130:  30 30 30 30 32 30 30 30 - 30 30 30 30 30 30 30 30 0000200000000000   
00000140:  30 30 30 30 30 30 31 30 - 30 30 30 30 30 30 30 30 0000001000000000   
00000150:  30 30 30 30 30 30 0D 0D - 41 30 32 54 45 53 54 49 000000  A02TESTI   
00000160:  47 4E 4F 52 45 2F 58 4D - 52 20 20 20 20 20 20 20 GNORE/XMR          
00000170:  20 20 20 20 20 20 20 20 - 20 20 20 20 20 20 20 20                    
00000180:  20 20 20 20 20 20 20 38 - 20 20 20 20 20 20 20 20        8           
00000190:  20 20 30 30 20 20 20 20 - 20 20 20 20 20 20 20 20   00               
000001A0:  20 20 20 20 20 20 20 0D - 0D 41 30 34 30 31 4B 4C          A0401KL   
000001B0:  30 37 34 4B 4C 4D 20 52 - 4F 59 41 4C 20 44 55 20 074KLM ROYAL DU    
000001C0:  31 31 39 4A 20 41 4B 31 - 35 4D 41 52 31 31 34 30 119J AK15MAR1140   
000001D0:  20 31 32 30 35 20 32 41 - 4D 53 41 4D 53 54 45 52  1205 2AMSAMSTER   
000001E0:  44 41 4D 20 20 20 20 4C - 48 52 4C 4F 4E 44 4F 4E DAM    LHRLONDON 
000001F0:  2F 48 45 41 54 48 52 49 - 4E 20 20 20 20 4F 30 20 /HEATHRIN    O0 
00000200:  20 20 37 33 37 20 20 20 - 20 20 20 20 20 20 46 20   737         F 
00000210:  41 43 3A 4B 4C 4D 20 43 - 49 54 59 48 4F 50 50 54 AC:KLM CITYHOPPT 
00000220:  4B 3A 4E 4A 54 3A 30 31 - 2E 32 35 0D 41 30 34 30 K:NJT:01.25 A040 
00000230:  32 4B 4C 30 37 34 4B 4C - 4D 20 52 4F 59 41 4C 20 2KL074KLM ROYAL 
00000240:  44 55 20 31 32 30 4A 20 - 41 4B 32 37 4D 41 52 31 DU 120J AK27MAR1 
00000250:  33 30 30 20 31 35 31 30 - 20 32 4C 48 52 4C 4F 4E 300 1510 2LHRLON   
00000260:  44 4F 4E 2F 48 45 41 54 - 48 52 41 4D 53 41 4D 53 DON/HEATHRAMSAMS   
00000270:  54 45 52 44 41 4D 20 20 - 20 20 49 4E 4F 20 20 20 TERDAM    INO      
00000280:  4F 30 20 20 20 37 33 35 - 20 20 20 20 20 20 20 20 O0   735           
00000290:  20 46 20 41 43 3A 4B 4C - 4D 20 43 49 54 59 48 4F  F AC:KLM CITYHO   
000002A0:  50 50 54 4B 3A 4E 4A 54 - 3A 30 31 2E 31 30 0D 0D PPTK:NJT:01.10     
000002B0:  41 31 32 41 4D 53 54 20 - 2A 47 41 4C 49 4C 45 4F A12AMST *GALILEO   
000002C0:  20 54 45 53 54 20 30 32 - 30 2D 36 34 38 37 35 31  TEST 020-648751   
000002D0:  31 0D 0D 0C             -                         1 
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4.2 The Configuration of Printers on the Galileo Host 
 

The Galileo system offers you the possibility to determine per workstation which type of printer you want to 
be linked to. This can be a Ticket printer, an Itinerary printer or a Mir Device. This section explains how a 
workstation is linked to the different types of printers. 
 
With the HMLD (How is My Line Doing) entry you can check which workstation is linked to what printer. If no 
printer is linked to this workstation, you will only see the workstation GTID and no Printer GTIDs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The first line shows what type of device it is. 
The second line shows which GTID this device has. 
 
‘ST’ determents the status of this printer: 
This can be UP (U), BUSY (B) or DOWN (D). 
 
‘FM’ determents the paper format of this printer: 
This can be itinerary (I), ticket (T) or blank (B). 
 
When a printer is not linked to a workstation and you want to link your workstation to this printer, type the 
following entry: 
Commando:   HMLM (Help Me Link Machine) 
Usage:   HMLMgtidD* 
Explanation:  * = I = Itinerary 

 A = MIR 
 X = Blank 

 
Example:   HMLMC5803EDI (Linkage of a Itinerary printer) 
Response:   CRT  ITN DEV ST FM/ 
    C58021 C5803DD D 
    (Terminal) (GTID printer) (Status)  
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The paper format (FM) has to be assigned to the printer.  
For a Mir device this option is not necessary. 
 
Commando:  HMOM (Help Me Operate Machine) 
Usage:  HMOMgtid-*** 
Explanation: ***= ITN = Itinerary 
    BLK = Blank (for “printability” printers) 
 
Example:  HMOMC5803D-ITN 
Response:  CRT  ITN DEV        ST  FM/ 
   C58021 C5803DD         D  I 
   (Terminal) (GTID printer) (Status) (Paper format) 
 
 
It could be necessary to change the printer status, type the following entry:  
 
Commando:  HMOM (Help Me Operate Machine) 
Usage:  HMOMGTID-* 
Explanation: *= U = Up 
   D = Down 
 
Example:  HMOMC5803D-U 
Response:  CRT  ITN DEV ST FM/ 
   C58021 C5803DD U I 
   (Terminal) (GTID printer) (Status) (Paper format) 
 
 
If you want to delink a printer, type the following entry: 
 
Delink:  HMLM/DELINK/* 
Usage:  HMLM/DELINK/* or HMLM/DELINK  
Explanation: *= I = Itinerary printer 
   A = Mir Device 
    HMLM/DELINK all printers are delinked 
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5. Troubleshooting 
 

5.1 TPassword (Thumbprint) Resets 
If a Galileo Desktop SSL CLIENT ID is to be moved to a different machine, then a password (Thumbprint) reset is 
normally required. Please contact your local Galileo representative and request a reset of that particular ClientID  
 

5.2 Galileo Desktop SSL Connection problems 
If you receive no response from the Galileo host than there could be a problem with the SSL connection to the 
Galileo SSL endpoints called: 
gdssl.galileo.com (12.17.227.30) or sslfpemea.galileo.com (194.24.254.186)  
 
1. Check if the Galileo SSL service is started. 

Go to Control panel → Administrative tools → Services. 

 
 
Check "Galileo SSL Tunnel" is running, If it is not, start it and try the connection again. 
IF it is running STOP it and restart the SSL connection. 
NOTE: if you go to properties you check the installed version. Make sure it is "Galileo SSL Client Service 
01.00.0003.00" or higher 

2. Test your own internet connection, DNS servers by pinging gdssl.galileo.com. 
Go to start – Run, type CMD and click on OK. Type C:\ping gdssl.galileo.com check first that it resolves 
the name and returns an IP address (12.17.227.30) if not your issue is with DNS. Does the ping reach its 
destination? If not it's a routing or firewall issue ASSUMING ICMP is open. Try pinging google.com. 

3. Test your firewall by Checking if port 443 (SSL) is available in your network 
Go to start – Run, type CMD and click on OK 
Type C:\telnet gdssl.galileo.com 443 and press enter. 
If you receive a blank screen and the cursor is flashing at the top left of screen, hit Ctrl-C on your keyboard a 
few dozen times to break the connection 
This means Port 443 is open and SSL is possible in your network 
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4. If you use a firewall please allow TCP traffic on port 443 to the following destination addresses 
 
 

Location DNS VIP 

Denver gdssl.galileo.com 12.17.227.30 
194.24.254.201 
216.113.159.225 

Langley sslfpemea.galileo.com 12.17.227.146 
194.24.254.204 
216.113.159.227 

Atlanta gdssl-atl.galileo.com 
 
 
 
gdsslpp-atl.galileo.com 

12.17.227.145 
194.24.254.193 
216.113.159.226 
 
216.113.131.33 

 

5. Next turn on the Logging in the SSL client. 
Go to C:\Program Files\Galileo\SSL and open SSLClientService.exe.config in notepad. 
Go to    </switches> and Change value = "Warning" to value ="ALL" for 
<add name="sourceSwitch" value="warning"/> 
 
Also go to <appsettings> and change value = "Warning" to value ="ALL" for 
<add key="Trace Level Override" value="Warning" />  
 
Save the file Delete the existing Log (c:\ SSLClientService.log) and Restart the SSL service. 
 
Check the log file. You will see the service start and all the ports that are listening e.g. 
SSLClient Information: 114 : Galileo SSL Tunnel Client Service is starting 
ProcessId=760  DateTime=2008-05-15T09:39:23.5564450Z 
 
SSLClient Information: 115 : Starting IPC traffic handler on port 2748 
ProcessId=760     DateTime=2008-05-15T09:39:23.5691395Z 
 
You will also see connection errors , such as: 
SSLClient Error: 304 : ServerConnection.Connect() - SocketException thrown: 
A connection attempt failed because the connected party did not properly respond after a period of time, or 
established connection failed because connected host has failed to respond 12.17.227.30:443 
ProcessId=760 DateTime=2008-05-15T09:40:07.7127985Z 

Make sure you undo these changes after you finish troubleshooting the SSL connection. 
 
Please check next Pages to see all listed Trace codes available 
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Level ID Textual info Meaning Adverse effects resolution 

info 100 

GalileoSSLTunnel.ServerRespon
se_Handler() - Redirect packet 
received to redirect_url 

The next time the SSL 
Client is run it will use the 
new gdssl server.   N/A 

info 101 
RawTCPProtocolHandler - 
SERVER DISCONNECTED. 

The server disconnected a 
non-FP/GD connection.   N/A 

info 102 

ServerConnection.Connect() - 
Local adapter address is : 
ip_address The local IP address   N/A 

info 103 

ServerConnection.Connect() - 
Constructing tunnel via HTTP 
Proxy proxy_address:proxy_port 

Indicates what web proxy is 
in use.   N/A 

info 104 

ServerConnection.Connect() - 
HTTP Proxy Response: 
proxy_response 

The web proxy HTTP 
response for a connect.   N/A 

info 105 Certificate Validated OK. Server SSL Certificate OK   N/A 

info 106 

ServerConnection.ReceivedServ
erData_Handler() - server sent 0 
bytes. 

Usually indicates the server 
closed the connection.   N/A 

info 107 

ServerConnection.ReceivedServ
erData_Handler() - sslStream 
was disposed before a read. 

Normal processing. The 
connection was closed.   N/A 

info 108 
TCPHandler.Listen() - Listening 
on port port 

Now accepting connections 
on this IP port.   N/A 

info 109 

TCPHandler.AcceptConnection_
Handler() - TCP Connection 
accepted. Local_connection_ip 

A new client application is 
now being served.   N/A 

info 110 

TCPHandler.AcceptConnection_
Handler() - Listening socket was 
closed. 

No longer accepting 
connections.   

If the SSL 
Client was not 
being stopped, 
this needs to 
be flagged to 
development 

info 111 
TCPSession.Run() - Exception 
thrown: exception       

info 112 

TCPSession.SendDataToServer(
) - Constructing TCP tunnel with 
Endpoint ip_address:port 

Endpoint is the actual 
server (eg IPCS or IPC) 
that is being targetted.   N/A 

info 113 
UDPHandler.ReceivedClientData
_Handler() - Got Data.     N/A 

info 114 
Galileo SSL Tunnel Client 
Service is starting…     N/A 

info 116 
Starting IPCS traffic handler on 
port port     N/A 

info 117 
Starting MQ Print traffic handler 
on port port     N/A 

info 118 
Starting GIDS traffic handler on 
port port     N/A 

info 119 
Starting TN3270 traffic handler 
on port port     N/A 
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info 119 
Starting PM Browser traffic 
handler on port port     N/A 

info 120 
Galileo SSL Tunnel Client started 
OK.     N/A 

info 121 
Galileo SSL Tunnel Client is 
stopping…     N/A 

info 122 
Galileo SSL Tunnel Client is 
stopped OK.     N/A 

info 123 
UDPHandler.Listen() - Running in 
SERVER mode. 

Clustered mode enabled. 
Only connections from 
remote machines are 
accepted.   N/A 

info 124 
UDPHandler.Listen() - Running in 
LOCAL mode. 

Local mode enabled. Only 
connections from the local 
machine are accepted.   N/A 

info 125 
TCPHandler.Listen() - Running in 
SERVER mode. 

Clustered mode enabled. 
Only connections from 
remote machines are 
accepted.   N/A 

info 126 
TCPHandler.Listen() - Running in 
LOCAL mode. 

Local mode enabled. Only 
connections from the local 
machine are accepted.   N/A 

info 130 GPM Wakeup sent. 
Local GPM wakeup 
initiated.   N/A 

info 200 

GalileoSSLTunnel.ServerRespon
se_Handler() - Server 
Disconnected!       

Warning 201 

IPCProtocolHandler.ClientDataR
eceived() - Client reconfiguration 
requested. 

The IPC has requested 
that the client (FP/GD) 
initiates a IPCS reconfig   N/A 

Warning 202 

TCPHandler.AcceptConnection_
Handler() - SocketException 
thrown: exception 

A client connection attempt 
failed.The client is denied a 
connection so will reflect 
this.   

Stop and 
restart the 
SSL Client. 

Warning 203 

TCPSession.ReceivedClientData
_Handler() - Exception thrown: 
exception 

The client sent us data 
which could not be 
obtained. This may be due 
to a client disconnecting.     

Warning 204 
TCPSession.OpenTunnel() - 
Exception handled: exception 

A connection to the SSL 
server could not be 
established. 

Most likely, all clients 
will fail. 

Ensure 
connectivity to 
the gd-
ssl.galileo.com 
server, eg. 
ping. 

Warning 220 
Exception during Service START: 
exception 

All or part of the SSL Client 
failed to start 

Hopefully this would 
be accompanied by a 
more descriptive error 
message.   

Error 300 

BOOTPProtocolHandler.ModifyU
DPResponse() - Exception 
thrown: exception 

There was a problem 
storing IPCS config info to 
the .config file 

hHost connectivity will 
fail for FP/GD/GPM 

Check 
permissions to 
the .config file. 
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Error 301 

BOOTPProtocolHandler.ModifyU
DPResponse() - Exception 
thrown: exception 

Most likely, the BOOTP 
config response from the 
IPCS is invalid 

Host connectivity will 
fail for FP/GD/GPM 

Increase 
logging to 
capture data 
dumps 
(Verbose) and 
send to 
development. 

Error 302 

GalileoSSLTunnel.ServerRespon
se_Handler() - Exception thrown: 
exception 

Should be accompanied by 
more meaningful log error     

Error 303 

ServerConnection.Connect() - 
AuthenticationException thrown: 
exception       

Error 304 

ServerConnection.Connect() - 
SocketException thrown: 
exception       

Error 305 
ServerConnection.Connect() - 
IOException thrown: exception       

Error 306 
ServerConnection.Close() - 
Exception thrown: exception       

Error 307 
ServerConnection.Send() - 
Exception thrown: exception       

Error 308 
ServerConnection.Send() - 
Exception thrown: exception       

Error 308 
ServerConnection.Send() - 
Exception thrown: exception       

Error 310 

ServerConnection.ReceivedServ
erData_Handler() - Exception 
thrown: exception       

Error 311 
UDPHandler.Listen() - Exception 
thrown: exception       

Error 312 

UDPHandler.ServerResponse_H
andler() - Exception thrown: 
exception       

Error 313 

UDPHandler.ReceivedClientData
_Handler() - Exception thrown: 
exception       

Error 314 

IPCProtocolHandler.ClientDataR
eceived() - Exception thrown: 
exception       

Error 315 

TCPSession.ReceivedClientData
_Handler() - client socket was 
null!       

Error 316 

BOOTPProtocolHandler.ModifyU
DPResponse() - Could not get 
machine IP in SERVER mode. 

Unable to get the local 
machine IP 

The SSl Client will be 
unable to accept any 
incoming client 
connections. 

check for valid 
IP address 
using 
ipconfig.exe 

Critical 400 Certificate error: policy error 
Server SSL Certificate 
Invalid 

No connections to the 
SSL server will be 
made. All connectivity 
through the Retor 
Client will fail. 

Server 
certificate 
should be 
checked by 
Travelport for 
validity. 
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Critical 401 
TCPHandler.TCPHandler() - 
Exception thrown: exception 

A problem occurred while 
attempting to create a local 
TCP socket for listening. 

It is likely that the 
Retro Client will not 
accept any 
connections from the 
local application that 
uses this port. Hence 
no host connectivity.   

Critical 402 

TCPHandler.Listen() - 
SocketException thrown:  
exception 

A problem occurred while 
attempting to start listening 
and accepting connections 
on a local TCP socket. 

It is likely that the 
Retro Client will not 
accept any 
connections from the 
local application that 
uses this port. Hence 
no host connectivity.   

Critical 403 

TCPHandler.Initialize() - 
SocketException thrown: 
exception 

A problem occurred during 
the initialization of the local 
listening TCP socket. 

The Retro Client will 
not accept any 
connections from the 
local application that 
uses this port. Hence 
no host connectivity.   

Critical 405 
TCPSession.Run() - Exception 
thrown: exception 

General failure, this will be 
accompanied by more 
detailed diagnostic errors.     

Critical 406 
UDPHandler.UDPHandler() - 
Exception thrown: exception 

Failure while starting to 
listen for UDP (IPCS) 
requests 

FP/GD will most likely 
fail to configure.   

Critical 407 
TCPHandler.TCPHandler() - 
Exception thrown:  exception 

Failure while starting to 
listen for TCP (all but 
IPCS) requests 

Accompanying errors 
should determine the 
actual problem.   

Critical 408 
TCPSession.SendDataToClient() 
- Less than 3 bytes sent 

No longer an error. Used to 
identify bad LCN data, 
however other connections 
may reasonably send very 
small packets.     

Verbose 900 

BOOTPProtocolHandler: 
Received UDP Data from 
Server:- data_dump 

infoal data dump of UDP 
server->client data     

Verbose 901 
Sending TCP data via SSL tunnel 
to server:- data_dump 

infoal data dump of client-
>server data     

Verbose 901 
Sending TCP data via SSL tunnel 
to server:- <Hidden data packet> 

infoal message of server-
>client data (authentication 
packet)     

Verbose 902 

TCPSession.SendDataToClient() 
- Sent length bytes to client: 
data_dump 

infoal data dump of TCP 
server->client data     

Verbose 903 

UDPHandler.SendDataToClient() 
- Sending data to client: 
data_dump 

infoal data dump of UDP 
server->client data     

Critical 4000 
Trace Level changed to 
tracelevel. Logging level was changed Log more/less info N/A 
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5.3 SSL FAQ’s 
 
What happens to a customer’s printer linkage? 
There will be no noticeable difference in the agent experience.  Printer linkage from a converted or non-converted 
terminal will continue to connect to a converted or non-converted printer server with no action required on the part 
of the converted agent 
 
Can a customer use a client ID from their agency PC at home? 
If they are using more then one workstation, they may need more than one client id per workstation depending on 
whether it’s a laptop with docking station or standard PC. 
 
Can customers have multiple ClientID on a workstation? 
Yes.   
 
What happens when the customer’s internet connection is disrupted / broken? 
The desktop will behave in the same manor as it does with a connection break today.  In FP 3.5, the status line 
will show a connection break, and the workstation will reconnect on the next agent entry.  GD will reconnect 
automatically.  GPM will try to reconnect whenever a connection break is detected. 
What if the customer’s ISP connection becomes unstable? 
Customers will need to work with their ISP to get a more stable connection. 
 
Will the customer’s connection be faster or slower than it is today? 
If they have better available bandwidth to their ISP than they do to the Galileo network, they should see an 
improvement in performance.  If they have less available bandwidth to their ISP than they have the Galileo 
network their performance will get worse.  Customers need to keep in mind that their performance will now be 
entirely related to their ISP bandwidth. 
 
How does your SSL solution protect my customer privacy information? 
The retro-client uses the highest available SSL cipher level available in your country, and encryption is 
established on your workstation, meaning your host connectivity is now encrypted on your agency LAN as well as 
the internet.  The SSL retro-client has the same level of privacy information security as our current leased line or 
router-based VPN solutions 
 
What if my desktop PC has Focalpoint/Galileo Desktop as well as Galileo Print Manager? 
The Galileo SSL retro-client will work with GPM on a shared workstation OR on a stand-alone workstation 
 
Does it work with Citrix? 
Yes, but not in a clustered environment.  We are looking to support clustered Citrix in Galileo Desktop 2.1.  Citrix 
requires special customization to work with SSL.  We are currently testing this solution, and are seeking 
customers willing to help us test.  A single workstation on a Citrix server can be converted to SSL without 
converting the rest of the Citrix workstations   
 
What about my 3rd party applications? 
If they connect via the Galileo Desktop (or Focalpoint) APIs, they will continue to function per normal 
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5.4 Useful Galileo entries: 
 
+J  : Check the GTID used in the Galileo Software. 
SON/Zxx  : Log in to the Galileo-system (xx = initials of the Galileo user) 
SOF  : Log off 
HMLD  : Check the status of the Galileo printers and Print buffers. 
HQSgtid  : Restart of a Print Job (gtid = GTID of the printer) 
HQC  : Show today’s print statistics 
HQCgtid  : Show the total number of queued print messages 

: (gtid = GTID van printer) 
 
HMLMgtidDI  : Link a Workstation to a Itinerary printer 
HMOMgtid-ITN : To configure a Gtid to be used as an Itinerary printer. 
HMOMgtid-U  : Change the printer queue status to Up (D=down). 
 
HMLMgtidDA  : Link a Workstation to a MIR (back office feed) 
HMOMgtid –U : Change the printer queue status to Up (D=down) 
TKPDID  : print an itinerary (after retrieving a booking file) 
TKPDAD  : creating a MIR (after retrieving a booking file) 
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